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1. Importante

1. Importante
Questa guida all’uso elettronica è intesa 
per chiunque usi il monitor Philips. Leggere 
accuratamente questo manuale d’uso prima di 
usare il monitor. Contiene informazioni e note 
importanti sul funzionamento del monitor.

La garanzia Philips è valida a condizione che 
il prodotto sia usato in modo corretto, in 
conformità alle sue istruzioni operative, dietro 
presentazione della fattura o dello scontrino 
originale, indicante la data d’acquisto, il nome 
del rivenditore, il modello ed il numero di 
produzione del prodotto.

1.1 Manutenzione e precauzioni di 
sicurezza

 Avvisi
L’utilizzo di controlli, regolazioni o procedure 
diverse da quelle specificate nelle presenti 
istruzioni possono esporre al rischio di scariche 
elettriche e pericoli elettrici e/o meccanici.

Leggere ed osservare le presenti istruzioni 
durante il collegamento e l’utilizzo del monitor 
del computer.

Funzionamento

•	 Tenere il monitor lontano dalla luce diretta 
del sole, da luci molto luminose e da altre 
fonti di calore. L'esposizione prolungata a 
questo tipo di ambienti potrebbe causare 
distorsioni nel colore e danni al monitor.

•	 Rimuovere qualsiasi oggetto che potrebbe 
cadere nei fori di ventilazione od ostacolare 
il corretto raffreddamento delle parti 
elettroniche del monitor. 

•	 Non bloccare i fori di ventilazione sulle 
coperture.

•	 Durante la collocazione del monitor 
assicurarsi che il connettore e la presa 
d’alimentazione siano facilmente accessibili.

•	 Se si spegne il monitor scollegando il cavo 
d’alimentazione o il cavo DC, attendere 
6 secondi prima di ricollegare il cavo 

d’alimentazione o il cavo DC per il normale 
funzionamento.

•	 Utilizzare sempre il cavo d’alimentazione 
approvato fornito da Philips. Se il cavo 
d’alimentazione è assente, rivolgersi al 
Centro Assistenza locale. (Fare riferimento 
al Centro Informazioni Consumatori e 
all’Assistenza Clienti) 

•	 Non far subire al monitor forti vibrazioni o 
impatti severi durante il funzionamento.

•	 Non colpire né lasciare cadere il monitor 
durante il funzionamento o il trasporto.

Manutenzione

•	 Per proteggere il monitor da possibili danni, 
non esercitare pressione eccessiva sul 
pannello LCD. Quando si sposta il monitor, 
afferrare la struttura per sollevarlo; non 
sollevare il monitor mettendo le mani o le 
dita sul pannello LCD.

•	 Se si prevede di non utilizzare il monitor 
per lunghi periodi, scollegarlo dalla presa di 
corrente.

•	 Scollegare il monitor dalla presa di corrente 
se è necessario pulirlo con un panno 
leggermente umido. Lo schermo può essere 
asciugato con un panno asciutto quando 
l’alimentazione è scollegata. Tuttavia, non 
utilizzare solventi organici come alcool, 
oppure liquidi a base di ammoniaca per 
pulire il monitor.

•	 Per evitare danni permanenti, non esporre 
il monitor a polvere, pioggia, acqua o 
eccessiva umidità.

•	 Se il monitor si bagna, asciugarlo con un 
panno asciutto. 

•	 Se sostanze estranee o acqua penetrano 
nel monitor, disattivare immediatamente 
l’alimentazione e scollegare il cavo 
d’alimentazione. Quindi, rimuovere la 
sostanza estranea oppure l’acqua ed inviare 
immediatamente il monitor ad un Centro 
Assistenza.

•	 Non immagazzinare o usare il monitor LCD 
in luoghi esposti a calore, luce diretta del 
sole o freddo estremo.
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•	 Per conservare prestazioni ottimali del 
monitor e utilizzarlo per un periodo 
prolungato, utilizzare il dispositivo in un 
luogo caratterizzato dalle seguenti condizioni 
ambientali: 

•	 Temperatura: 0-40°C 32-95°F 

•	 Umidità: 20-80% RH 

Informazioni importanti sul Burn-in/immagini 
“fantasma”.

•	 Attivare sempre uno screen saver con 
animazione quando si lascia il monitor 
inattivo. Attivare sempre un’applicazione 
d’aggiornamento periodico dello schermo se 
il monitor visualizzerà contenuti statici che 
non cambiano. La visualizzazione ininterrotta 
di immagini statiche per un lungo periodo 
di tempo può provocare sullo schermo il 
fenomeno di "immagine residua" o "immagine 
fantasma", noto anche come "burn-in". 
Il "Burn-in", la "sovrimpressione" o "immagine 
fantasma" è un fenomeno ben noto alla 
tecnologia dei pannelli LCD. Nella maggior 
parte dei casi il fenomeno "burn-in", "immagine 
residua" o "immagine fantasma" scompare 
gradatamente nel tempo dopo che il monitor 
è stato spento.

 Avviso

La mancata attivazione di uno screen saver, o di 
una applicazione che aggiorna periodicamente 
lo schermo, può provocare gravi fenomeni di 
“burn-in”, o “immagine residua” o “immagine 
fantasma” che non spariranno e che non 
potranno essere corretti. I danni di cui sopra 
non sono coperti dalla garanzia.

Assistenza

•	 La copertura del monitor deve essere 
aperta esclusivamente da tecnici qualificati.

•	 In caso di necessità di qualsiasi documento 
per la riparazione o l'integrazione, 
contattare il proprio Centro Assistenza 
locale. (Fare riferimento al capitolo "Centri 
Informazioni Consumatori") 

•	 Fare riferimento alla sezione "Specifiche 
tecniche" per informazioni sul trasporto.

•	 Non lasciare il monitor in un’automobile/
bagagliaio esposto alla luce diretta del sole.

 Nota

Consultare un tecnico dell’assistenza se il 
monitor non funziona normalmente oppure se 
non si è sicuri di come procedere dopo avere 
seguito le istruzioni di questo manuale .
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1.2 Avvisi e legenda
La sezione che segue fornisce una descrizione 
di alcuni simboli convenzionalmente usati in 
questo documento. 

Note, Attenzione e Avvisi
In questa guida, ci sono blocchi di testo 
accompagnati da icone specifiche che sono 
stampati in grassetto o corsivo. Questi blocchi 
contengono note, avvisi alla cautela ed 
all’attenzione. Sono usati come segue:

 Nota

Questa icona indica informazioni e suggerimenti 
importanti che aiutano a fare un uso migliore 
del computer.

 Attenzione

Questa icona indica informazioni che spiegano 
come evitare la possibilità di danni al sistema o 
la perdita di dati.

 Avviso

Questa icona indica la possibilità di lesioni 
personali e spiega come evitare il problema.

Alcuni avvisi possono apparire in modo diverso 
e potrebbero non essere accompagnati da 
un’icona. In questi casi, la presentazione specifica 
dell’avviso è prescritta dalla relativa autorità 
competente.

1.3 Smaltimento del prodotto e dei 
materiali d’imballaggio

Apparecchi elettrici ed elettronici da smaltire 
- WEEE

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2012/19/EU governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government office, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.
Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 
All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 
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Taking back/Recycling Information for 
Customers

Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation innational take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors,  
which recycle  all materials (products and 
related packaging material) in accordance with 
all Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit 

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. Impostazione del monitor

2.1 Installazione

 Contenuti della confezione

VGA (optional) DVI (optional)

Audio cable (optional)Power cable 

Register your product and get support at

www.philips.com/welcome
233V5

Quick
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使用产品前请阅读使用说明

保留备用

 Installazione della base
1. Collocare il monitor, a faccia in giù, su una 

superficie liscia, prestando attenzione a non 
graffiare o danneggiare lo schermo.

2. Attaccare/far scorrere il supporto nel 
monitor finché scatta in posizione.

3. Tenere la base del monitor con entrambe 
le mani ed inserire con fermezza la base 
nel supporto.

Cavo audio (optional)

DVI (optional)VGA (optional)
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 Collegamento al PC

233V5LSB, 233V5LSB2

4

 Ingresso potenza AC
 Ingresso VGA
  Ingresso DVI-D (disponibile per modelli 
selezionati)

  Sistema antifurto Kensington

233V5LAB

6

4

5

 Ingresso potenza AC
  Ingresso VGA
 Ingresso DVI-D
 Uscita cuffie

  Ingresso audio
  Sistema antifurto Kensington

233V5LHAB, 233V5LHAW

6

4

5

  Ingresso potenza AC
  Ingresso VGA
 Ingresso HDMI  
 Uscita cuffie

  Ingresso audio
  Sistema antifurto Kensington

233V5LHSB2

5

5

4

4

 Ingresso alimentazione CA/CC
 Ingresso VGA
 Ingresso HDMI
 Uscita audio HDMI
 Sistema antifurto Kensington
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Collegamento al PC

1. Collegare saldamente il cavo 
d’alimentazione sul retro del monitor.

2. Spegnere il computer e staccare il cavo 
d’alimentazione.

3. Collegare il cavo segnale del monitor al 
connettore video sul retro del computer.

4. Collegare i cavi d’alimentazione del 
computer e del monitor ad una presa di 
corrente nelle vicinanze.

5. Accendere il computer ed il monitor. Se sul 
monitor appare un’immagine, l’installazione 
è riuscita.
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2.2 Funzionamento del monitor

  Descrizione del pannello frontale del 
prodotto

233V5LSB, 233V5LSB2, 233V5LHSB2:

5

6 2347

Accendere e spegnere il monitor.

Accedere al menu OSD.
Confermare la regolazione 
dell’OSD.

Per tornare al livello precedente 
del menu OSD.

Regolare il livello di luminosità.

Regolare il menu OSD.

Passa alla visualizzazione 4:3.

Regolare automaticamente il 
monitor.

233V5LAB, 233V5LHAB, 233V5LHAW

5

6 2347

Accendere e spegnere il monitor.

Accedere al menu OSD.
Confermare la regolazione 
dell’OSD.

Per tornare al livello precedente 
del menu OSD.

Regolare il livello di luminosità.

Regolare il menu OSD.

Regolare il volume 
dell'altoparlante.

Regolare automaticamente il 
monitor.
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 Descrizione del menu OSD

Che cos’è il menu OSD (On-Screen Display)?
Il menu OSD (On-Screen Display) è una 
funzione di tutti i monitor LCD Philips. 
Consente all’utente di regolare le prestazioni 
dello schermo o di selezionare le funzioni del 
monitor direttamente tramite una finestra 
di istruzioni a video. Di seguito è mostrata 
un’illustrazione della semplice interfaccia OSD:

 233V5LAB:














233V5LSB, 233V5LSB2:












 

233V5LSB (per modello analogico):







 



     

               

 



 







233V5LHAB, 233V5LHAW, 233V5LHSB2:














Istruzioni semplici e di base sui tasti di 
controllo
Nel menu OSD mostrato in precedenza, 
premere i tasti   sul pannello frontale del 
monitor per spostare il cursore e premere il 
tasto OK per confermare la scelta o la modifica.
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Il menu OSD

Di seguito c’è una descrizione generale della 
struttura del menu OSD. Questa può essere 
utilizzata come riferimento quando in seguito si 
lavorerà sulle diverse regolazioni.

Main menu Sub menu

Picture

Wide Screen, 4:3

0~100

0~100

Picture Format

Brightness

Contrast

OSD Settings

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup
0~100

On, Off
Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution Notification
Reset

Information

Language English,Español,Français,Deutsch,Italiano,

Nederlands, Svenska, Suomi, Polski, Čeština

한국어, 日本語, Maryar, Українська, 

Português do Brazil, Ελληνική , 繁體中文 

Português,Русский,简体中文,Türkçe,  

Color

6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temperature

sRGB

User Define

Audio
0~100

On, Off

Volume

Mute

(available for selective models)

(available for selective models)

(available for selective models)

(available for selective models)

(available for selective models)

VGA

HDMI

DVIInput

On, OffSmartContrast

On, OffOver scan

1.8, 2.0, 2.2, 2.4, 2.6Gamma

Audio source Audio in, HDMI

 Notifica di risoluzione

Questo monitor è progettato per rendere 
le prestazioni ottimali alla sua risoluzione 
originaria di 1920 x 1080 @ 60 Hz. Quando il 
monitor è impostato su una risoluzione diversa, 
all’accensione è visualizzato un avviso: Usare 
1920 x 1080 @ 60 Hz per ottenere i migliori 
risultati.

La visualizzazione dell’avviso può essere 
disattivata dal menu Configurazione del menu 
OSD (On Screen Display).

 Funzioni fisiche

Inclinazione
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2.3 Rimozione del supporto e della 
base

 Rimozione della base

Prima di iniziare a smontare la base del monitor, 
osservare le istruzioni che seguono per evitare 
eventuali danni o lesioni.

1. Collocare il monitor, a faccia in giù, su una 
superficie liscia, prestando attenzione a non 
graffiare o danneggiare lo schermo.

2.  Premere i fermagli per staccare la base dal 
supporto.

1

3. Premere il tasto di rilascio per staccare la 
colonna della base.

2

 Nota 
Questo monitor accetta un’interfaccia di 
montaggio compatibile VESA 100 mm x 100 
mm.

100mm

100mm
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3. Informazioni sul prodotto

3.1 SmartContrast

 Che cos’è?

Tecnologia unica che analizza dinamicamente 
i contenuti visualizzati ed ottimizza 
automaticamente il rapporto di contrasto del 
LCD per la massima chiarezza e piacevolezza 
visiva, aumentando l'illuminazione per 
immagini più chiare, luminose e nitide oppure 
diminuendola per la visualizzazione di immagini 
chiare su sfondi scuri. 

 Perché ne ho bisogno?

Vuoi la chiarezza ed il comfort visivo migliore 
per ogni tipo di contenuto. SmartContrast 
controlla dinamicamente il contrasto e regola 
l’illuminazione per immagini e videogiochi chiari, 
nitidi e luminosi, oppure per visualizzare testo 
chiaro e leggibile per i lavori d’ufficio. Riducendo 
il consumo energetico del monitor, si risparmia 
sui costi e si allunga la durata del monitor. 

 Come funziona?

Quando si attiva SmartContrast i contenuti 
visualizzati saranno analizzati in tempo reale 
per regolare i colori e controllare l’intensità 
dell’illuminazione. Questa funzione migliora il 
contrasto in modo dinamico per una grandiosa 
esperienza d’intrattenimento quando si 
guardano video o mentre si gioca.

3.2 Philips SmartControl Lite

Il nuovo software SmartControl Lite Phillips 
permette di controllare il monitor usando 
una semplice interfaccia grafica. Le regolazioni 
complicate appartengono al passato; questo 
software facile da usare guida durante le 
procedure per regolare con precisione la 
calibratura del colore, Fase/Clock, punto di 
bianco RGB, eccetera.

Dotato della tecnologia più avanzata in materia 
di algoritmi core per velocità d’elaborazione e 
risposta, questo software compatibile Windows 

7 dotato di attraenti icone animate è pronto 
per migliorare la tua esperienza con i monitor 
Philips!

 Installazione

•	 Attenersi alle istruzioni e completare 
l’installazione.

•	 L’avvio si esegue ad installazione terminata.

•	 Se si vuole avviare l’applicazione in un 
secondo tempo, fare clic sul collegamento del 
desktop o nella barra degli strumenti.

Procedura Wizard (guidata) primo avvio
•	 La prima volta, dopo l’installazione di 

SmartControl Lite, si passerà automaticamente 
alla procedura Wizard (guidata) primo avvio.

•	 che guiderà passo a passo nel corso delle 
procedure di regolazione delle prestazioni del 
monitor.

•	 Per avviare la procedura guidata in un secondo 
tempo, si può andare al menu Plug-in.

•	 Usando il pannello Standard si possono 
regolare altre opzioni senza ausilio della 
procedura guidata.
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 Inizio con il pannello Standard:

Menu Adjust (Regolazione):

•	 Il menu Adjust (Regolazione) permette di 
regolare: Brightness (Luminosità), Contrast 
(Contrasto), Focus (Fuoco), Position 
(Posizione) e Resolution (Risoluzione).

•	 Seguire le istruzioni ed eseguire la 
regolazione.

•	 La voce Cancel (Annulla) chiede all’utente 
se vuole annullare l’installazione.
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Menu Color (Colore):

•	 Il menu Color (Colore) permette di 
regolare: RGB, Black Level (Livello di 
nero), White Point (Punto bianco) e Color 
Calibration (Calibratura colore).

•	 Seguire le istruzioni ed eseguire la 
regolazione.

•	 Fare riferimento alla tabella che segue per 
informazioni dettagliate sulle voci dei menu 
secondari in base all’ingresso.

•	 Esempio di Color Calibration (Calibratura 
colore).
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1. "Show Me" (Mostrami) avvia il Tutorial della 
calibratura colore.

2.	 Start (Avvia) – Avvia la sequenza di 6 fasi 
della calibratura colore.

3.	 Quick View (Visione rapida) carica le 
immagini prima/dopo.

4.	 Fare clic sul tasto Cancel (Annulla) per 
tornare al pannello principale Color 
(Colore).

5.	 Enable color calibration (Abilita calibratura 
colore) - Per impostazione predefinita 
questa opzione è attivata. Se è deselezionata, 
la calibratura colore non ha luogo ed i tasti 
Avvia e Visione rapida sono disabilitati.

6.	 La schermata della calibratura deve avere le 
informazioni dei diritti esclusivi.

Prima schermata della calibratura colore:

•	 Il tasto Previous (Precedente) è disabilitato 
fino alla seconda schermata colore.

•	 Il tasto Next (Avanti) va alla schermata 
successiva (ci sono 6 schermate).

•	 Il tasto Avanti dell’ultima schermata porta al 
pannello File > Presets (Preselezioni).

•	 Il tasto Cancel (Annulla) chiude l’interfaccia 
e torna alla schermata Plug-in.

Options > Preferences (Opzioni > Preferenze) 
- Sarà attivo solo quando si seleziona 
Preferences (Preferenze) dal menu a discesa 
Options (Opzioni). Sugli schermi non supportati, 
con capacità DDC/CI, saranno disponibili solo 
le schede Help (Guida) e Options (Opzioni).

•	 Visualizza le impostazioni correnti delle 
preferenze.

•	 Una casella selezionata abilita la funzione. 
La casella può essere selezionata e 
deselezionata.

•	 La voce Enable Context Menu (Abilita 
menu contestuale) sul desktop è 
selezionata (attivata) per impostazione 
predefinita. Enable Context Menu (Abilita 
menu contestuale) visualizza le opzioni 
di SmartControl Lite di Select Presets 
(Selezione predefiniti) e Tune Display 
(Regola schermo) del menu contestuale 
del desktop (clic tasto destro del 
mouse). Disabled (Disabilitato) rimuove 
SmartControl Lite dal menu contestuale.

•	 La voce Enable Task Tray (Abilita icona 
area di notifica) è selezionata (attivata) per 
impostazione predefinita. Enable Context 
Menu (Abilita menu contestuale) mostra il 
menu dell’area di notifica di SmartControl 
Lite. Facendo clic col tasto destro del 
mouse sull’icona nell’area di notifica, è 
visualizzato un menu di opzioni con le voci 
Help (Guida), Technical Support (Supporto 
tecnico), Check for Update (Controlla 
aggiornamenti), About (Informazioni) ed 
Exit (Esci). Quando la voce Enable task 



16

3. Informazioni sul prodotto

tray menu (Abilita menu area di notifica) 
è disabilitata, l’icona dell’area di notifica 
visualizza solo EXIT (ESCI).

•	 La voce Run at Startup (Esegui all’avvio) 
è selezionata (attivata) per impostazione 
predefinita. Quando disabilitato, 
SmartControl Lite non si avvierà all’avvio, 
né sarà nell’area di notifica. Il solo modo 
per avviare SmartControl Lite è usare il 
collegamento sul desktop oppure il file 
del programma. Tutte le impostazioni 
configurate per essere eseguite all’avvio non 
si caricheranno quando questa casella è 
deselezionata (disabilitata).

•	 Enable transparency mode (Abilita 
trasparenza) (Windows 7, Vista, XP). 
L’impostazione predefinita è 0% Opaco.

Options > Input (Opzioni > Ingresso) – Sarà 
attivo solo quando si seleziona Input (Ingresso) 
dal menu a discesa Options (Opzioni). Sugli 
schermi non supportati, con capacità DDC/CI, 
saranno disponibili solo le schede Help (Guida) 
e Options (Opzioni). Tutte le atre schede di 
SmartControl Lite non sono disponibili.

•	 Visualizza il pannello Istruzioni Source 
(origine) e le impostazioni correnti 
dell’origine dell’ingresso.

•	 Su schermi con un solo ingresso, questo 
pannello non sarà visibile.

Options > Audio (Opzioni > Audio) – Sarà 
attivo solo quando si seleziona Audio dal menu 
a discesa Options (Opzioni).

Sugli schermi non supportati, con capacità 
DDC/CI, saranno disponibili solo le schede 
Help (Guida) e Options (Opzioni).

Help > User Manual (Guida > Manuale d’uso) 
– Sarà attivo solo quando si seleziona User 
Manual (Manuale d’uso) dal menu a discesa 
Help (Guida). Sugli schermi non supportati, con 
capacità DDC/CI, saranno disponibili solo le 
schede Help (Guida) e Options (Opzioni).
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Help > Version (Guida > Versione) - Sarà 
attivo solo quando si seleziona Version 
(Versione) dal menu a discesa Help (Guida). 
Sugli schermi non supportati, con capacità 
DDC/CI, saranno disponibili solo le schede 
Help (Guida) e Options (Opzioni).

Menu contestuale sensibile
Il Context Sensitive Menu (menu contestuale 
sensibile) è abilitato per impostazione 
predefinita. Se la voce Enable Context Menu 
(Abilita menu contestuale) è stata selezionata 
nel pannello Options > Preferences (Opzioni > 
Preferenze), il menu sarà visibile.

Menu contestuate ha tre voci:
•	 SmartControl Lite - Quando selezionato, 

è visualizzata la schermata About 
(Informazioni) sullo schermo.

•	 Select Preset (Selezione predefiniti) - 
Fornisce un menu gerarchico di impostazioni 
predefinite salvate per l’uso immediato. 
Un segno di spunta mostra l’impostazione 
predefinita correntemente selezionata. Dal 
menu a discesa può essere richiamata la 
voce Valori predefiniti.

•	 Tune Display (Regola schermo) - Apre il 
pannello di controllo di SmartControl Lite.

Menu area di notifica abilitato
Il menu dell’area di notifica può essere 
visualizzato facendo clic col tasto destro del 
mouse sull’icona SmartControl Lite nell’area 
di notifica. Il clic col tasto sinistro del mouse 
avvierà l’applicazione.

L’area di notifica ha cinque voci:
•	 Help (Guida) - Accesso al User Manual 

(Manuale d’uso): Apre il file del User 
Manual (Manuale d’uso) usando il browser 
predefinito.

•	 Technical Support (Supporto tecnico) - 
Visualizza la pagina del Supporto tecnico.

•	 Check for Update (Controlla aggiornamenti) 
- Porta alla pagina PDI Landing e verifica la 
versione dell’utente con quella più recente 
disponibile.

•	 About (Informazioni) - Visualizza 
informazioni dettagliate di riferimento: 
versione del prodotto, informazioni sulla 
pubblicazione e nome del prodotto.

•	 Exit (Esci) - Chiude SmartControl Lite 

Per eseguire di nuovo SmartControl Lite 
selezionare SmartControl Lite dal menu 
Program (Programmi), fare doppio clic sull’icona 
del desktop, oppure riavviare il sistema.
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Menu area di notifica disabilitato
Quando l’area di notifica è disabilitata nella 
cartella delle preferenze, è disponibile solo la 
selezione EXIT (ESCI). Per rimuovere in modo 
completo SmartControl Lite dall’area di notifica, 
disabilitare la voce Run at Startup (Esegui 
all’avvio) in Options (Opzioni) > Preferences 
(Preferenze).

 Nota
Tutte le illustrazioni di questa sezione sono 
solo per riferimento. La versione del software 
SmartControl può essere modificata senza 
preavviso. Controllare sempre il sito Portrait 
ufficiale www.portrait.com/dtune/phl/enu/index 
per scaricare l'ultima versione del software 
SmartControl.
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4. Specifiche tecniche
Immagine/Schermo
Tipo di pannello LCD LCD TFT
Illuminazione LED
Dimensioni del pannello 23" L (58,4cm)
Rapporto proporzioni 16:9
Dimensioni pixel 0,265 x 0,265 mm
Luminosità 250 cd/m²;200 cd/m²(233V5LSB2, 233V5LHSB2)
SmartContrast 10,000,000:1
Rapporto di contrasto (tipico) 1000:1; 600:1(233V5LSB2, 233V5LHSB2)
Tempo di risposta (tipico) 5 ms
Risoluzione ottimale 1920 x 1080 @ 60Hz
Angolo di visuale 170° (H) / 160° (V) @ C/R > 10

90° (H) / 50° (V) @ C/R > 10(233V5LSB2, 233V5LHSB2)
Colori dello schermo 16,7 milioni
Frequenza d'aggiornamento 
verticale

56Hz - 76Hz

Frequenza orizzontale 30kHz - 83kHz
sRGB SÌ
Connettività
Ingresso segnale 233V5LSB, 233V5LSB2, 233V5LAB: VGA(analogico), 

DVI(digitale,HDCP) (disponibile per modelli selezionati)
233V5LHAB, 233V5LHAW, 233V5LHSB2: VGA(analogico), 
HDMI(digitale,HDCP)

Ingresso/uscita audio
233V5LAB, 233V5LHAB, 233V5LHAW: Ingresso audio PC, 
uscita cuffie
233V5LHSB2: Uscita audio HDMI

Segnale d’ingresso Sincronia separata, Sync on Green
Utilità
Funzioni utili 233V5LSB, 233V5LSB2, 233V5LHSB2:

233V5LAB, 233V5LHAB, 233V5LHAW:

Lingue OSD Inglese, Tedesco, Spagnolo, Francese, Italiano, Ungherese, 
Olandese, Portoghese, Portoghese Brasiliano, Polacco, Russo, 
Svedese, Finlandese, Turco, Ceco, Ucraino, Cinese semplificato, 
Giapponese, Coreano, Greco, Cinese tradizionale

Altre funzioni utili Sistema antifurto Kensington
Compatibilità Plug & Play DDC/CI, sRGB, Windows 7/8/Vista/XP, Mac OSX, Linux 
Montaggio	VESA 100x100 mm

Base
Inclinazione -5/+20 
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233V5LAB: 
Alimentazione
Acceso 21,31 W (tip.), 26,15 W (max.)
Sospensione (Standby) 0,5W
Spento 0,5W
Indicatore di alimentazione Modalità accensione: Bianco, Standby/Sospensione: Bianco 

(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz

233V5LSB: 
Alimentazione
Acceso 21,55W (tip.), 22,22 W (max.)

or 21,55W (tip.), 24,23 W (max.) (per modello analogico)
Sospensione (Standby) 0,5W
Spento 0,5W
Indicatore di alimentazione Modalità accensione: Bianco, Standby/Sospensione: Bianco 

(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz

233V5LSB2: 
Alimentazione
Acceso 20,23W (tip.), 21,57 W (max.)
Sospensione (Standby) 0,5W
Spento 0,5W
Indicatore di alimentazione Modalità accensione: Bianco, Standby/Sospensione: Bianco 

(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz

233V5LHSB2: 
Alimentazione
Acceso 18,77W (tip.), 20,7 W (max.)
Sospensione (Standby) 0,5W
Spento 0,3W
Indicatore di alimentazione Modalità accensione: Bianco, Standby/Sospensione: Bianco 

(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz

233V5LHAB, 233V5LHAW: 
Alimentazione
Acceso 21,02 W (tip.), 28,51 W (max.)
Sospensione (Standby) 0,5W
Spento 0,3W
Indicatore di alimentazione Modalità accensione: Bianco, Standby/Sospensione: Bianco 

(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz
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Dimensioni
Prodotto con base (LxHxP) 547 x 416 x 219 mm
Prodotto senza base (LxHxP) 547 x 340 x 53 mm
Peso
Prodotto con base 3,5kg
Prodotto senza base 3,13kg
Prodotto con la confezione 4,985kg

Condizioni  operative
Portata temperatura (operativa) Da 0° C a 40° C
Portata temperatura  
(non operativa) 

Da -20° C a 60° C

Umidità relativa 20% a 80%
MTBF 30.000 ore

Ambiente
ROHS SÌ
EPEAT Silver (www.epeat.net)
Confezione 100% riciclabile
Energy Star SÌ
Conformità  e  standard

Approvazioni a norma di legge
CE Mark, FCC Class B, CU, SEMKO, BSMI, ETL,  
ISO9241-307, TCO Certified, SASO, EPA, CB, PSB, KUCAS

Struttura

Colore
233V5LAB, 233V5LSB, 233V5LSB2, 233V5LHSB2, 233V5LHAB: 
Nero 
233V5LHAW: Bianco

Finitura Superficie

 Nota

1. La certificazione EPEAT Gold o Silver è valida solo dove Philips registra il prodotto. Visitare il sito 
www.epeat.net per conoscere lo stati della registrazione nel proprio paese.

2. Questi dati sono soggetti a cambiamenti senza preavviso. Andare all’indirizzo www.philips.com/

support per scaricare la versione più recente del foglio informativo.
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4.1 Risoluzione e Modalità 
predefinite

 Risoluzione massima 
1920 x 1080 @ 60 Hz (ingresso analogico)
1920 x 1080 @ 60 Hz (ingresso digitale)

 Risoluzione raccomandata
1920 x 1080 @ 60 Hz (ingresso digitale)

Frequenza 
orizzontale (kHz)

Resolution 
(Risoluzione)

Frequenza 
verticale (Hz)

31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

44,77 1280 x 720 59,86

63,89 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

 Nota
Notare che lo schermo funziona meglio alla 
risoluzione originale di 1920 x 1080 @ 60Hz. 
Attenersi a questa raccomandazione per 
ottenere la qualità migliore di visualizzazione.
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5. Risparmio energetico
Se la scheda video o il software installato sul 
PC è conforme agli standard DPM VESA, il 
monitor può ridurre automaticamente il suo 
consumo energetico quando non è in uso. 
Quando è rilevato l'input dalla tastiera, dal 
mouse o altri dispositivi, il monitor si "risveglia" 
automaticamente. La tabella che segue mostra il 
consumo energetico e le segnalazioni di questa 
funzione automatica di risparmio energetico:

233V5LAB: 

Definizione del risparmio energetico
Modalità 

VESA
Video

Sincronia 
orizzontale 

Sincronia 
verticale 

Potenza usata Colore del LED

Attiva ATTIVO Sì Sì
21,31 W (tipico)
26,15 W (max.)

Bianco

Sospensione DISATTIVO No No 0,5W (tip.)
Bianco 

(lampeggiante)

Spegnimento DISATTIVO - - 0,5W (tip.) DISATTIVO

233V5LSB: 

Definizione del risparmio energetico
Modalità 

VESA
Video

Sincronia 
orizzontale 

Sincronia 
verticale 

Potenza usata Colore del LED

Attiva ATTIVO Sì Sì

21,55 W (tip.)
22,22 W (max.)
or 21,55 W (tip.)
24,23 W (max.)

(per modello 
analogico)

Bianco

Sospensione DISATTIVO No No 0,5W (tip.)
Bianco 

(lampeggiante)

Spegnimento DISATTIVO - - 0,5W (tip.) DISATTIVO

233V5LHAB, 233V5LHAW: 

Definizione del risparmio energetico
Modalità 

VESA
Video

Sincronia 
orizzontale 

Sincronia 
verticale 

Potenza usata Colore del LED

Attiva ATTIVO Sì Sì
21,02 W (tipico)
28,51 W (max.)

Bianco

Sospensione DISATTIVO No No 0,5W (tip.)
Bianco 

(lampeggiante)

Spegnimento DISATTIVO - - 0,3W (tip.) DISATTIVO

La configurazione che segue è usata per 
misurare il consumo energetico di questo 
monitor.

•	 Risoluzione originale: 1920 x 1080

•	 Contrasto: 50%

•	 Luminosità: 250 nit

•	 Temperatura colore: 6500k con modello 
tutto bianco

 Nota
Questi dati sono soggetti a cambiamenti senza 
preavviso.

233V5LSB2: 

Definizione del risparmio energetico
Modalità 

VESA
Video

Sincronia 
orizzontale 

Sincronia 
verticale 

Potenza usata Colore del LED

Attiva ATTIVO Sì Sì
20,23 W (tip.)

21,57 W (max.)
Bianco

Sospensione DISATTIVO No No 0,5W (tip.)
Bianco 

(lampeggiante)

Spegnimento DISATTIVO - - 0,5W (tip.) DISATTIVO

233V5LHSB2: 

Definizione del risparmio energetico
Modalità 

VESA
Video

Sincronia 
orizzontale 

Sincronia 
verticale 

Potenza usata Colore del LED

Attiva ATTIVO Sì Sì
18,77 W (tip.)
20,7 W (max.)

Bianco

Sospensione DISATTIVO No No 0,5W (tip.)
Bianco 

(lampeggiante)

Spegnimento DISATTIVO - - 0,3W (tip.) DISATTIVO

La configurazione che segue è usata per 
misurare il consumo energetico di questo 
monitor.

•	 Risoluzione originale: 1920 x 1080

•	 Contrasto: 50%

•	 Luminosità: 200 nit

•	 Temperatura colore: 6500k con modello 
tutto bianco

 Nota
Questi dati sono soggetti a cambiamenti senza 
preavviso.
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Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

Congratulations!

This product is designed for both you and the 
planet! 

TCO Development works for 
sustainable IT - manufacture, 
use and recycling of IT products 

reflecting environmental, social and economic 
responsibility. 

TCO Certified is a third party verified program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certified represents one of the toughest 
certifications for ICT products worldwide. 

Some of the Usability features of TCO 
Certified Displays: 

•	 Visual Ergonomics for image quality 
is tested to ensure top performance 
and reduce sight and strain problems. 
Important parameters are Resolution, 
Luminance, Contrast, Reflection and Colour 
characteristics

•	 Products are tested according to rigorous 
safety standards at impartial laboratories 

•	 Electric and magnetic fields emissions as 
low as normal household background levels

•	 Workload ergonomics to ensure a good 
physical environment  

Some of the Environmental features of TCO 
Certified Displays:  

•	 Production facilities have an Environmental 
Management System (EMAS or ISO 14001) 

•	 Low energy consumption to minimize 
climate impact  

•	 Restrictions on Chlorinated and 
Brominated flame retardants, plasticizers, 
plastics and heavy metals such as cadmium, 
mercury and lead (RoHS compliance) 

•	 Both product and product packaging is 
prepared for recycling

•	 The brand owner offers take-back options 

Corporate Social Responsibility 

•	 The brand owner demonstrates the 
product is manufactured under working 
practices that promote good labour 
relations and working conditions.  

The Criteria Document can be downloaded 
from our web site. The criteria included in 
this label have been developed by TCO 
Development in co-operation with scientists, 
experts, users as well as manufacturers all 
over the world. Since the end of the 1980s 
TCO has been involved in influencing the 
development of IT equipment in a more user 
and environmentally friendly direction. Our ICT 
product labeling system began in 1992 and is 
now requested by users and ICT-manufacturers 
all over the world.  

For displays with glossy bezels, the user should 
consider the placement of the display as the 
bezel may cause disturbing reflections from 
surrounding light and bright surfaces.

For more information, please visit:  
www.tcodevelopment.com

Technology for you and the planet
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EPEAT

(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 
51 environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Benefits of EPEAT

Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 
standards 

•	 EN60950-1:2006+A11:2009+A1: 
2010+A12:2011 (Safety requirement of 
Information Technology Equipment).

•	 EN55022:2010 (Radio Disturbance 
requirement of Information Technology 
Equipment).

•	 EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

•	 EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

•	 EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

•	 2006/95/EC (Low Voltage Directive).

•	 2004/108/EC (EMC Directive).

•	 2009/125/EC (ErP Directive, EC No. 
1275/2008 Implementing   Directive 
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards 

•	 ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

•	 GS EK1-2000:2011 (GS mark requirement).

•	 prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).

•	 MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).

•	 TCO CERTIFIED (Requirement for 
Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 
guidelines for energy efficiency.

 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the 
equipment and receiver.

•	 Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device.

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following 
two conditions: (1) this device may not cause 
harmful interference, and (2) this device must 
accept any interference received, including 
interference that may cause undesired 
operation.

Commission Federale de la Communication 
(FCC Declaration)

 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de l'article 
15 Des règles de la FCC. Ces limites sont 
conçues de façon à fourir une  protection 
raisonnable contre les interférences nuisibles 
dans le cadre d'une installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

•	 Réorienter ou déplacer l’antenne de 
réception.

•	 Augmenter la distance entre l’équipement 
et le récepteur.

•	 Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so 
on) should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.



28

6. Informazioni legali

North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften.

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III	¤	5	Abs.	4	der	Röntgenverordnung	erfüllt	
sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden.

2.  nur original-Ersatzteile verwendet werden. 

3.  bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird.

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

环保使用期限 

此标识指期限 ( 十年 ), 电子信息产品中含有的有

毒有害物质或元素在正常使用的条件下不会发生

外泄或突变 , 电子信息产品用户使用该电子信息

产品不会对环境造成严重污染或对其人身、 财产

造成严重损害的期限．

中国能源效率标识 
根据中国大陆《能源效率标识管理办法》，本显示器符合以下要求：

关闭状态能耗（W)
能源效率(cd/W)

< 0.5
> 1.05

1级
GB 21520-2008

能效等级
能效标准

详细有关信息请查阅中国能效标识网：http://www.energylabel.gov.cn/

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此
产品或产品寿命终止时，请遵守国家废弃电器电
子产品回收处理相关法律法规，将其交给当地具
有国家认可的回收处理资质的厂商进行回收处
理。

EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. 

On the label, you can find the energy efficiency 
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

 Note

The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7. Assistenza Clienti e 
Garanzia

7.1 Criteri di valutazione dei pixel 
difettosi dei monitor a schermo 
piatto Philips

La Philips si impegna a consegnare prodotti della 
più alta qualità. Utilizziamo alcuni dei processi 
di produzione più avanzati nell'industria e delle 
rigorose procedure di controllo della qualità. 
Tuttavia i difetti dei pixel o dei pixel secondari 
dei pannelli LCD TFT usati nei monitor a 
schermo piatto a volte sono inevitabili. Nessun 
produttore è in grado di garantire che tutti 
i pannelli siano privi di difetti dei pixel, ma la 
Philips garantisce che qualsiasi monitor con un 
numero inaccettabile di difetti sarà riparato 
oppure sostituito sotto garanzia. Questa nota 
spiega i diversi tipi di difetti dei pixel e definisce 
i livelli accettabili di difetto per ogni tipo. Per 
avere diritto alla riparazione o sostituzione 
in garanzia, il numero di pixel difettosi di un 
pannello LCD TFT deve eccedere questi 
livelli accettabili. Ad esempio: non più dello 
0,0004% dei pixel secondari di un monitor può 
essere difettoso. Inoltre, Philips stabilisce degli 
standard di qualità ancora più alti per alcuni 
tipi o combinazioni di difetti dei pixel che sono 
più evidenti di altri. Questi criteri di valutazione 
sono validi in tutto il mondo.

Pixel e pixel secondari
Un pixel, o elemento dell'immagine, è composto 
di tre pixel secondari nei tre colori primari 
rosso, verde e blu. Molti pixel messi insieme 
formano un'immagine. Quando tutti i pixel 
secondari di un pixel sono illuminati, i tre pixel 
secondari colorati appaiono insieme come un 
singolo pixel bianco. Quando sono tutti spenti, 
i tre pixel secondari colorati appaiono insieme 

come un pixel nero. Altre combinazioni di pixel 
illuminati o spenti appaiono come singoli pixel 
di altri colori.

Tipi di difetti dei pixel
I difetti dei pixel e dei pixel secondari appaiono 
sullo schermo in modi diversi. Esistono due 
categorie di difetti dei pixel e diversi tipi di 
difetti dei pixel secondari all'interno di ogni 
categoria.

Punti luminosi
Questi difetti appaiono come pixel o pixel 
secondari che sono sempre accesi oppure 
'attivi'. Un punto luminoso è un pixel secondario 
che risalta sullo schermo quando il monitor 
visualizza un motivo scuro. Ci sono vari tipi di 
punti luminosi:

Un pixel secondario rosso, verde o blu 
illuminato

Due pixel secondari adiacenti illuminati:
 - Rosso + Blu = Viola
 - Rosso + Verde = Giallo
 - Verde + Blu = Ciano (blu chiaro)

secondarisecondarisecondari

pixel



31

7. Assistenza Clienti e Garanzia
Prossimità dei difetti dei pixel
Poiché i difetti dei pixel e dei pixel secondari 
dello stesso tipo che si trovano vicini fra loro 
sono più evidenti, la Philips specifica anche le 
tolleranze per la prossimità dei difetti dei pixel.

Tolleranze dei difetti dei pixel
Per avere diritto alla riparazione o sostituzione 
in garanzia a causa di pixel difettosi, un pannello 
LCD TFT di un monitor a schermo piatto 
Philips deve avere una quantità di pixel o pixel 
secondari difettosi che eccede le tolleranze 
elencate nelle tabelle che seguono.

Tre pixel secondari adiacenti illuminati (un pixel 
bianco).

 Nota
Un punto luminoso rosso o blu deve essere 
oltre il 50 percento più luminoso dei punti 
adiacenti mentre un punto luminoso verde è il 
30 percento più luminoso dei punti adiacenti.

Punti neri
Compaiono come pixel o pixel secondari 
sempre spenti o 'inattivi'. Un punto nero è 
un pixel secondario che risalta sullo schermo 
quando il monitor visualizza un motivo chiaro. 
Ci sono vari tipi di punti neri:

PUNTI LUMINOSI LIVELLO ACCETTABILE
1 pixel secondario acceso 3
2 pixel secondari adiacenti accesi 1
3 pixel secondari adiacenti accesi (un pixel bianco) 0
Distanza tra due punti luminosi* >15mm
Totale di punti bianchi di tutti i tipi 3

PUNTI NERI LIVELLO ACCETTABILE
1 pixel secondario scuri 5 o meno
2 pixel secondari scuri adiacenti 2 o meno
3 pixel secondari scuri adiacenti 0
Distanza tra due punti neri* >15mm
Totale di punti neri di tutti i tipi 5 o meno

TOTALE PUNTI DIFETTOSI LIVELLO ACCETTABILE
Totale di punti bianchi o punti neri di tutti i tipi 5 o meno

 Nota

1. 1 o 2 pixel secondari adiacenti = 1 punto difettoso

2. Questo monitor è conforme ISO 9241-307. (ISO 9241-307: Requisiti ergonomici, metodi d’analisi 
e di verifica della conformità per i dispositivi elettronici di visualizzazione) 

3. La norma ISO9241-307 succede alla norma nota come ISO13406, che è stata emendata 
dall’International Organisation for Standardisation (ISO) il 13 Novembre 2008.
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7.2 Assistenza Clienti e Garanzia
Per informazioni sulla copertura della garanzia e sui requisiti aggiuntivi di assistenza validi per la vostra 
area, visitare il sito web www.philips.com/support.  È inoltre possibile contattare il numero del vostro 
Philips Customer Care Center più vicino elencato in basso.

Informazioni di contatto per zona dell’EUROPA OCCIDENTALE:

Paese CSP Numero verde Prezzo Orario d’apertura

Austria RTS +43 0810 000206 € 0.07 Mon to Fri : 9am - 6pm

Belgium Ecare +32 078 250851 € 0.06 Mon to Fri : 9am - 6pm

Cyprus Alman 800 92 256 Free of charge Mon to Fri : 9am - 6pm

Denmark Infocare +45 3525 8761 Local call tariff Mon to Fri : 9am - 6pm

Finland Infocare  +358 09 2290 1908 Local call tariff Mon to Fri : 9am - 6pm

France Mainteq +33 082161 1658 € 0.09 Mon to Fri : 9am - 6pm

Germany RTS +49 01803 386 853 € 0.09 Mon to Fri : 9am - 6pm

Greece Alman +30 00800 3122 1223 Free of charge Mon to Fri : 9am - 6pm

Ireland Celestica +353 01 601 1161 Local call tariff Mon to Fri : 8am - 5pm

Italy Anovo Italy +39 840 320 041 € 0.08 Mon to Fri : 9am - 6pm

Luxembourg Ecare +352 26 84 30 00 Local call tariff Mon to Fri : 9am - 6pm

Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri : 9am - 6pm

Norway Infocare +47 2270 8250 Local call tariff Mon to Fri : 9am - 6pm

Poland MSI +48 0223491505 Local call tariff Mon to Fri : 9am - 6pm

Portugal Mainteq 800 780 902 Free of charge Mon to Fri : 8am - 5pm

Spain Mainteq +34 902 888 785 € 0.10 Mon to Fri : 9am - 6pm

Sweden Infocare +46 08 632 0016 Local call tariff Mon to Fri : 9am - 6pm

Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm

United Kingdom Celestica +44 0207 949 0069 Local call tariff Mon to Fri : 8am - 5pm

Informazioni di contatto per la Cina:

Paese Call center Numero assistenza clienti

China PCCW Limited 4008 800 008

Informazioni di contatto per il NORD AMERICA:

Paese Call center Numero assistenza clienti

U.S.A. EPI-e-center (877) 835-1838

Canada EPI-e-center (800) 479-6696
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Informazioni di contatto per zona dell’EUROPA ORIENTALE E CENTRALE:

Paese Call center CSP Numero assistenza clienti

Belarus NA IBA
+375 17 217 3386 
+375 17 217 3389

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA MR Service Ltd +385 (01) 640 1111

Czech Rep. NA Asupport 420 272 188 300

Estonia NA FUJITSU
+372 6519900(General) 
+372 6519972(workshop)

Georgia NA Esabi +995 322 91 34 71

Hungary NA Profi Service

+36 1 814 8080(General) 
+36 1814 8565(For AOC&Philips 
only)

Kazakhstan NA Classic Service I.I.c. +7 727 3097515

Latvia NA ServiceNet LV
+371 67460399 
+371 27260399

Lithuania
NA

UAB Servicenet
+370 37 400160(general) 
+370 7400088 (for Philips)

Macedonia NA AMC +389 2 3125097

Moldova NA Comel +37322224035

Romania NA Skin +40 21 2101969

Russia NA CPS +7 (495) 645 6746

Serbia&Montenegro NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

the republic of Belarus NA ServiceBy + 375 17 284 0203

Turkey NA Tecpro +90 212 444 4 832 

Ukraine NA Topaz +38044 525 64 95

Ukraine NA Comel +380 5627444225

Informazioni di contatto per zona dell’AMERICA LATINA:

Paese Call center Numero assistenza clienti

Brazil
Vermont 

0800-7254101

Argentina 0800 3330 856
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Informazioni di contatto per l'area APMEA:

Paese ASP Numero assistenza clienti Orario d’apertura

Australia AGOS NETWORK PTY LTD 1300 360 386 Mon.~Fri. 9:00am-5:30pm

New Zealand Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm

Hong Kong 
Macau

Company: Smart Pixels 
Technology Ltd.

Hong Kong: 
Tel: +852 2619 9639 
Macau:Tel: (853)-0800-987

Mon.~Fri. 9:00am-6:00pm  
Sat. 9:00am-1:00pm

India REDINGTON INDIA LTD
Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Mon.~Fri. 9:00am-5:30pm

Indonesia
PT. CORMIC SERVISINDO 
PERKASA

+62-21-4080-9086 (Customer 
Hotline) 
+62-8888-01-9086 (Customer 
Hotline)

Mon.~Thu. 08:30-12:00; 
13:00-17:30  
Fri. 08:30-11:30; 13:00-17:30

Korea Alphascan Displays, Inc 1661-5003
Mon.~Fri. 9:00am-5:30pm 
Sat. 9:00am-1:00pm

Malaysia R-Logic Sdn Bhd +603 5102 3336
Mon.~Fri. 8:15am-5:00pm 
Sat. 8:30am-12:30am

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore
Philips Electronics Singapore 
Pte Ltd (Philips Consumer Care 
Center)

(65) 6882 3966
Mon.~Fri. 9:00am-6:00pm 
Sat. 9:00am-1:00pm

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00

Thailand
Axis Computer System Co., 
Ltd.

(662) 934-5498 Mon.~Fri. 8:30am~05:30pm

South Africa Computer Repair Technologies 011  262 3586 Mon.~Fri. 8:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00 

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi Minh 
City Branch

+84 8 38248007 Ho Chi Minh 
City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho 
Province

Mon.~Fri. 8:00-12:00, 13:30-
17:30,Sat. 8:00-12:00

Philippines
EA Global Supply Chain 
Solutions ,Inc.

(02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm

Armenia 
Azerbaijan 
Georgia 
Kyrgyzstan 
Tajikistan

Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Uzbekistan
Soniko Plus Private Enterprise 
Ltd

+99871 2784650 Mon.~Fri. 09:00 - 18:00

Turkmenistan Technostar Service Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00

Japan
フィリップスモニター・サ
ポ ートセンター

0120-060-530 Mon.~Fri. 10:00 - 17:00



35

8. Risoluzione dei problemi e FAQ

8.  Risoluzione dei problemi 
e FAQ

8.1 Risoluzione dei problemi

Questa pagina tratta i problemi che possono 
essere corretti dall’utente. Se il problema 
persiste, dopo avere tentato queste soluzioni, 
mettersi in contatto con l’Assistenza Clienti 
Philips.

 Problemi comuni

Nessuna immagine (il LED d’alimentazione 
non è acceso)
•	 Assicurarsi che il cavo d'alimentazione sia 

collegato ad una presa di corrente ed alla 
presa sul retro del monitor.

•	 Per prima cosa, accertarsi che il tasto 
d’alimentazione sul pannello frontale 
del monitor sia in posizione di OFF 
(spegnimento), poi premerlo per metterlo 
in posizione ON (d’accensione).

Nessuna immagine (il LED d’alimentazione è 
bianco)
•	 Assicurarsi il computer sia acceso.

•	 Assicurarsi che il cavo segnale sia collegato 
in modo appropriato al computer.

•	 Assicurarsi che il connettore del cavo del 
monitor non abbia pin piegati. In caso 
affermativo, sostituire il cavo.

•	 Potrebbe essere stata attivata la funzione di 
risparmio energetico.

Lo schermo visualizza il messaggio

Attention

Check cable connection

•	 Assicurarsi che il cavo del monitor sia 
collegato in modo appropriato al computer. 
(Fare anche riferimento alla Guida Rapida)

•	 Assicurarsi che il connettore del cavo del 
monitor non abbia pin piegati.

•	 Assicurarsi il computer sia acceso.

Il tasto AUTO non funziona
•	 La funzione Auto è applicabile solo in 

modalità VGA analogico. Se il risultato non 
è soddisfacente, si possono eseguire le 
regolazioni manuali usando il menu OSD.

 Nota
La funzione Auto non è applicabile in 
modalità DVI digitale perché non è necessaria.

Sono presenti segni visibili di fumo o scintille
•	 Non eseguire alcuna delle procedure di 

risoluzione dei problemi

•	 Scollegare immediatamente il monitor dalla 
presa di corrente per motivi di sicurezza

•	 Chiamare immediatamente un 
rappresentante del Centro Assistenza Philips.

 Problemi dell’immagine

L’immagine non è centrata
•	 Regolare la posizione dell’immagine usando 

la funzione “Auto” dei controlli OSD.
•	 Regolare la posizione dell’immagine usando 

la voce Phase/Clock (Fase/Clock) del menu 
OSD Setup (Impostazione). È valido solo in 
modalità VGA.

L’immagine vibra sullo schermo
•	 Controllare che il cavo segnale sia collegato 

in modo appropriato alla scheda video del 
PC.

Appare uno sfarfallio verticale

•	 Regolare la posizione dell’immagine usando 
la funzione “Auto” dei controlli OSD.

•	 Eliminare le barre orizzontali usando la 
voce Phase/Clock (Fase/Clock) del menu 
OSD Setup (Impostazione). È valido solo in 
modalità VGA.

Appare uno sfarfallio orizzontale

•	 Regolare la posizione dell’immagine usando 
la funzione “Auto” dei controlli OSD.
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•	 Eliminare le barre orizzontali usando la 
voce Phase/Clock (Fase/Clock) del menu 
OSD Setup (Impostazione). È valido solo in 
modalità VGA.

L’immagine appare sfuocata, indistinta o troppo 
scura
•	 Regolare il contrasto e la luminosità usando 

il menu OSD.

Dopo avere spento il monitor, rimane una 
"immagine residua", "immagine fantasma" o 
"burn-in".
•	 La visualizzazione ininterrotta di immagini 

statiche per un lungo periodo di tempo può 
provocare sullo schermo il fenomeno di 
“immagine residua” o “immagine fantasma”, 
noto anche come “burn-in”. Il "Burn-in", la 
"sovrimpressione" o "immagine fantasma" 
è un fenomeno ben noto alla tecnologia 
dei pannelli LCD. Nella maggior parte 
dei casi il fenomeno "burn-in", "immagine 
residua" o "immagine fantasma" scompare 
gradatamente nel tempo dopo che il 
monitor è stato spento.

•	 Attivare sempre uno screen saver con 
animazione quando si lascia il monitor 
inattivo.

•	 Attivare sempre un’applicazione 
d’aggiornamento periodico dello schermo 
se il monitor LCD visualizzerà contenuti 
statici che non cambiano.

•	 I casi più gravi di "burn-in” o “immagine 
residua” o di “immagine fantasma” non 
scompaiono e non possono essere risolti. 
Tali danni non sono coperti dalla garanzia.

L'immagine appare distorta. Il testo è indistinto 
o sfuocato.
•	 Impostare la risoluzione schermo del 

PC sulla stessa risoluzione originale 
raccomandata per il monitor.

Sullo schermo appaiono dei punti verdi, rossi, 
blu, neri e bianchi
•	 I punti residui sono una caratteristica 

normale dei cristalli liquidi usati dalla 
tecnologia moderna. Fare riferimento alla 
sezione Criteri di valutazione dei pixel 
difettosi per altri dettagli.

La luce del LED "accensione" è troppo forte e 
disturba
•	 La luce del LED d’accensione può essere 

regolata usando il menu OSD Setup 
(Impostazione).

Per altra assistenza, fare riferimento all’elenco 
Centri Informazioni Assistenza Clienti e 
rivolgersi ad un rappresentante del Servizio 
clienti Philips.

8.2 Domande generiche

Domanda 1:   Quando installo il mio monitor, 
che cosa devo fare se lo 
schermo visualizza il messaggio 
"Cannot display this video 
mode" (Impossibile visualizzare 
questa modalità video)?

Risposta:  Risoluzione raccomandata per 
questo monitor: 1920 x 1080 a 
60Hz.

•	  Scollegare tutti i cavi, poi collegare il PC al 
monitor usato in precedenza.

•	  Aprire il menu Start di Windows e 
selezionare Settings (Impostazioni)/Control 
Panel (Panello di controllo). Nella finestra 
del Control Panel (Pannello di controllo) 
selezionare l’icona Display (Schermo). Nella 
finestra Proprietà - Schermo, selezionare 
la scheda “Settings” (Impostazioni) Nella 
scheda Impostazioni, nell’area denominata 
“desktop area” (Risoluzione dello schermo), 
spostare il dispositivo di scorrimento su 
1920 x 1080 pixel.

•	  Aprire le "Advanced Properties" (Proprietà 
Avanzate) ed impostare la Frequenza di 
aggiornamento su 60Hz, poi fare clic su OK.

•	  Riavviare il computer e ripetere le istruzioni 
dei punti 2 e 3 per verificare che il PC sia 
impostato su 1920 x 1080 a 60Hz.

•	  Spegnere il computer, scollegare il vecchio 
monitor e ricollegare il monitor LCD Philips.

•	  Accendere il monitor e poi accendere il PC.

Domanda 2:   Qual è la frequenza 
d’aggiornamento raccomandata 
per il monitor LCD?

Risposta:  La frequenza d’aggiornamento 
raccomandata per i monitor 
LCD è 60Hz. Nel caso ci siano 
dei disturbi sullo schermo, la 
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frequenza d'aggiornamento può 
essere regolata su un valore 
massimo di 75Hz per cercare di 
risolvere il problema.

Domanda 3:   Che cosa sono i file .inf e 
.icm del CD-ROM? Come si 
installano i driver (.inf e .icm)?

Risposta:  Questi sono i file driver del 
monitor. Seguire le istruzioni 
del Manuale d’uso per installare 
i driver. La prima volta che si 
installa il monitor, il computer 
potrebbe richiedere i driver del 
monitor (file .inf e .icm ) oppure 
il disco del driver. Seguire le 
istruzioni per inserire il (CD-
ROM in dotazione) fornito in 
dotazione. I driver del monitor 
(file .inf e .icm) saranno installati 
automaticamente.

Domanda 4:   Come si regola la risoluzione?
Risposta:  La scheda video / il driver video 

ed il monitor determinano 
insieme le risoluzioni disponibili. 
La risoluzione preferita si 
seleziona nel Pannello di 
controllo Windows® usando le 
"Proprietà - Schermo".

Domanda 5:   Che cosa faccio se mi perdo 
durante le procedure di 
regolazione del monitor?

Risposta:  Premere il tasto OK e poi 
selezionare "Reset" (Ripristina) 
per richiamare tutte le 
impostazioni predefinite.

Domanda 6:   Lo schermo LCD è resistente 
ai graffi?

Risposta:  In generale si raccomanda di 
non sottoporre la superficie 
del pannello ad impatti e di 
proteggerla da oggetti dalla 
forma appuntita o arrotondata. 
Quando si maneggia il monitor, 
assicurarsi di non applicare 
pressioni alla superficie del 
pannello. Diversamente le 
condizioni della garanzia 
potrebbero essere modificate.

Domanda 7:   Come si pulisce la superficie 
dello schermo LCD?

Risposta:  Usare un panno pulito, morbido 
e asciutto per la pulizia normale. 
Usare alcool isopropilico per 
una pulizia più accurata. Non 
usare altri solventi come alcool 
etilico, etanolo, acetone, esano, 
eccetera.

Domanda 8:   Posso modificare l'impostazione  
colore del monitor?

Risposta:  Sì, le impostazioni colore 
possono essere modificate 
usando, i comandi OSD, come 
segue,

•	  Premere "OK" per visualizzare il menu OSD 
(On Screen Display)

•	  Premere la "Down Arrow" (freccia giù) 
per selezionare l'opzione "Color" (Colore) 
e poi premere il tasto "OK" per accedere 
alle impostazioni colore; ci sono tre 
impostazioni, come segue.
1.	  Color Temperature (Temperatura 

colore); Le due impostazioni sono: 
6500K e 9300K. Con la temperatura 
colore 6500K il pannello appare "caldo, 
con toni rosso-bianchi", mentre con la 
temperatura colore 9300K il pannello 
appare "freddo con toni blu-bianchi".

2.	  sRGB; è l'impostazione standard 
per assicurare il corretto scambio di 
colori tra i vari dispositivi (e.g. video/
fotocamere digitali, monitor, stampanti, 
scanner, eccetera).

3.	  Personalizzato; si possono scegliere 
le impostazioni preferite del colore 
regolando rosso, verde e blu.

 Nota:
Una misurazione del colore della luce irradiato 
da un oggetto mentre è riscaldato. Questa 
misurazione è espressa in termini di scala 
assoluta (gradi Kelvin). Temperature Kelvin 
basse, come 2004K, sono i rossi; temperature 
più alte - come 9300K - sono i blu. La 
temperatura neutra è il bianco, a 6504K.
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8. Risoluzione dei problemi e FAQ

Domanda 9:   Posso collegare il mio monitor 
LCD a qualsiasi PC, postazione 
di lavoro o Mac?

Risposta:  Sì. Tutti i monitor LCD Philips 
sono compatibili con PC, Mac 
e postazioni di lavoro standard. 
Potrebbe essere necessario un 
cavo adattatore per collegare 
il monitor al sistema Mac. 
Rivolgersi al rivenditore Philips 
per altre informazioni.

Domanda 10:  I monitor LCD Philips sono 
Plug-and-Play?

Risposta:  Sì, i monitor sono compatibili 
Plug-and-Play con Windows 7/
Windows 8/Vista/XP/NT, Mac 
OSX, Linux.

Domanda 11:  Che cos’è l’Image Sticking, 
o Image Burn-in, o 
sovrimpressione, o immagine 
fantasma dei pannelli LCD?

Risposta:  La visualizzazione ininterrotta di 
immagini statiche per un lungo 
periodo di tempo può provocare 
sullo schermo il fenomeno di 
“immagine residua” o “immagine 
fantasma”, noto anche come 
“burn-in”. Il "Burn-in", la 
"sovrimpressione" o "immagine 
fantasma" è un fenomeno 
ben noto alla tecnologia dei 
pannelli LCD. Nella maggior 
parte dei casi il fenomeno 
"burn-in", "immagine residua" o 
"immagine fantasma" scompare 
gradatamente nel tempo dopo 
che il monitor è stato spento.
Attivare sempre uno screen 
saver con animazione quando si 
lascia il monitor inattivo.
Attivare sempre un’applicazione 
d’aggiornamento periodico dello 
schermo se il monitor LCD 
visualizzerà contenuti statici che 
non cambiano.

 Avviso
La mancata attivazione di uno screen saver, o di 
una applicazione che aggiorna periodicamente 
lo schermo, può provocare gravi fenomeni di 

“burn-in”, o “immagine residua” o “immagine 
fantasma” che non spariranno e che non 
potranno essere corretti. I danni di cui sopra 
non sono coperti dalla garanzia.

Domanda 12:  Perché lo schermo non 
visualizza il testo in modo 
nitido e mostra dei caratteri 
frastagliati?

Risposta:  Il monitor LCD funziona la 
meglio con la sua risoluzione 
originale di 1920 x 1080 a 
60Hz. Usare questa risoluzione 
per ottenere la visualizzazione 
migliore.

Domanda 13: Come faccio per sbloccare/
bloccare il mio tasto di scelta rapida?

Risposta:  Premere per 10 secondi il 
tasto  per sbloccare/
bloccare il tasto di scelta 
rapida, sul monitor apparirà il 
messaggio “Attenzione” e lo 
stato sbloccato/bloccato, come 
mostrato nelle illustrazioni che 
seguono. 

Attention

Monitor controls locked
 

Attention

Monitor control unlocked
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